MPTool – Multi-Project Scheduling Tool
MPTool is an MS Windows program which lets companies create and send work schedules to their
clients and sub-contractors. A company can also create work schedules for itself which help manage a
day’s tasks and employee assignments. The tool has been designed for small business contractors who
need to keep track of multiple jobs, but don’t have the time or desire to become computer experts. A
section called “Getting Started” at the end of this document has a list of steps to help you quickly get
started using the tool. Please read the document before doing those steps.
MPTool builds three types of schedules (Job schedules for your clients, Sub-Contractor schedules for
your subs and Day schedules for yourself) from information you input about your jobs, clients, subcontractors and employees. The input data uses the following assumptions:
·

Every job has a description and one associated client

·

Every job is made up of one or more tasks

·

Every task has a description and one associated sub-contractor (or main contractor)

·

Every task has one or more days the associated sub-contractor will be working

MPTool has four windows for input data and one window for the created schedules. The input windows
are Manpower, Client List, Sub Contractor List and Employee List. The schedule window is called
Schedules. The Manpower window is used to put in job, task and task day information and build
schedules. The list windows are used to maintain names, addresses and contact information (phones and
e-mail) for clients, sub contractors and employees. The Schedules window is used to show, add
comments to, print and e-mail the generated work schedules.

The sections below explain how to use the four windows and show examples of each. All four windows
have these common elements.
·

A caption bar (the top bar in the window that has the MPTool logo) - This is the standard
Windows caption bar allowing you to close or minimize the program.

·

A menu bar (the bar directly below the caption bar) - The File, View, Lists, and Help menu items
are available on all the windows. Use the View menu item to go from one window to another.

·

A message area (on the right side of the menu bar) - MPTool puts one or more messages into this
area when there is no other obvious feedback or when an error occurs. If the messages contain an
error message, the area will turn red. Left mouse clicking on the arrow on the right side of the
message area will cause the message area to drop down to let you see multiple messages.
Clicking any message when the area is expanded will put the area back to a single line. The
message area will automatically clear when you start doing something unrelated to your last
action.

·

A current cell color - When a cell in a grid any of the windows becomes current, MPTool
changes that cell’s background color. This helps you keep track of where you are when moving
around the grids to input or edit data.
ManPower Window

MPTool starts up displaying the Manpower window. This window is where you input the job
information used to build your schedules. If this were the first time you started, the window would have
the first three rows followed by a blank row. The first three rows are ‘frozen’ and not affected by the
vertical scroll bar. The blank row will always follow any job and task rows you input. In the example,

the blank row is row 20. The first three columns are also ‘frozen’ and not affected when you use the
horizontal scroll bar. Let’s look at what’s in these frozen rows and columns before discussing how to
enter jobs and tasks.
Frozen Rows 1-3
·

Days Settings (rows 1,2 under the column named Days) - These two cells contain the dates (Jan
18, 2006 and Apr 18, 2006 in the example) that define the days available for task scheduling.
Notice the dates in the non-frozen columns in these first two rows. The first non-frozen column
(column four) begins with Jan 18, 2006 and the last column (if you scrolled to it) ends with Apr
18, 2006. MPTool initially sets these dates to the curreent date and the current date plus 180
days. You can change either the starting date or the ending date by left mouse clicking one of the
two days cells. A calendar will appear which allows you to choose your new date. Manpower
will then add or subtract non-frozen columns to update the available days.

·

Range Setting (rows 1 and 2 under the column called Range) - These two cells (Row 4 Jan 18,
2006 and Row 4 Apr 18, 2006 in the example) define the area of rows and columns that will be
used for building schedules. The upper cell locates the upper left hand corner of the area. The
lower cell locates the lower right hand corner. The area is initially set to encompass only the first
cell in the non-frozen rows and columns. You set these values by selecting a group of cells and
then left mouse clicking one of the two cells under the Range column. To select a group of cells,
move the mouse over the cell that will be the upper left corner of the selection, then hold the left
mouse button down and drag the mouse to the cell that will be the lower right. When you let up
on the mouse button, the area you selected will be highlighted. The highlight will disappear and
the range values will be updated when you left mouse click one of the two Range setting cells.
Left mouse clicking the Range column header will turn the highlight back on. MPTool only
looks at the cells defined by the Range values when building schedules. This lets you create
schedules for anything from a single task of a single job to all tasks of all jobs.

·

Date Columns (Row 1, 2 - all columns to the right of the Range column) – The date column
headers contain the first letter of the weekday. Row 1 under these columns shows the month and
year and row 2 shows the day of the month. Later, we’ll see how these columns are used to
define the days a sub-contractor will be working on a task.

·

Overbook Row (Row 3 under the date columns) - MPTool requires that one and only one of the
sub-contractors be the main contractor. (See the Subs window section to learn how to set a subcontractor to be the main contractor) The main contractor is treated differently from the other
sub-contractors in a couple of ways. First, the titles of the schedules built by MPTool will
contain the information (name, address, etc.) of the main contractor. Second, the main contractor
can define the number of men his company will have working on a particular task on a particular
day. Notice in the Manpower example the two letter codes that appear in the date columns on the
task rows. Every sub-contractor has an associated unique two letter code that is part of the
information defined in the Subs window. This code is displayed in the date column when the
date is a working day for that sub-contractor. A main contractor has the option of using a man
number instead of the code. If you’ve chosen the man number option for the main contractor, the
row 3 cells under the date columns can be used for overbook checking. Right mouse click any of
those date cells on Row 3. A drop-down list will allow you to select a number. This number is
the maximum amount of men you would want to schedule for all tasks for that date. Use the
Tools menu to check for over booked days. MPTool will sum all the cells in a column having

man numbers and compare the sum against the Row 3 cell number. If the sum is larger than the
row 3 cell value, an error message is generated telling you what date you have an overbooking
on.
Frozen Columns 1-3
·

Completed Indicators (column 1 for task rows) - All task rows in the Manpower window will
contain a checkbox in column 1 that can be toggled on and off by left mouse clicking. A checked
box indicates that the task has been completed. When MPTool generates schedules, it normally
shows the dates a sub-contractor will be working on a task. If a box is checked, the word
“Completed” will be shown in place of the dates. The completed indicators are also used when
MPTool looks for late or unscheduled tasks. The date column that has today’s date will be
highlighted in yellow. A task which has no working days marked to the right of today’s column
is considered to be late. A task with no marked working days is unscheduled. Use the Tools
menu item to check for late or unscheduled tasks MPTool generates messages telling you which
task rows have a problem. Any task rows marked as completed will not be tested.

·

Job and Task Descriptions (Column 2 for job and task rows) - Notice in the example that this
column is not wide enough to see the full description. You can widen the column by putting the
mouse over the right vertical bar in the column header (just after the word Days) and dragging it
to the right. Dragging works like selecting. Hold the left mouse button down, move the mouse to
where you want and let up the left mouse button. The column will automatically expand. Right
mouse clicking the column header will restore the original width. The full description will
always be shown during an edit regardless of the column width. When a job or task row is first
created, the description “New Job” or “New Task” will be put in the column. To edit a
description, first move to the description by using the keyboard (arrow keys, tab, enter) or left
mouse clicking. Then hit the enter key. An editable text box with the full description will appear.
Edit the text and hit either the tab key or the enter key. The text box will disappear and the

modified text will replace the old description. You’ll be positioned to the description following
the one you just edited. To get out of an edit without updating your changes and maintain your
current position, hit the Esc key. You can also go into the edit mode without having to hit the
enter key by right mouse clicking the description.
·

Client and Sub-Contractor Names (Column 3 for job and task rows) - This column can be
widened by dragging the right vertical bar of the column header named Range. Right mouse
click the column header to restore the column’s original width. When you put client and subcontractor information into the Clients and Subs windows, MPTool generates lists of their
names. When you first add a job or task row to the Manpower window, a name on the
appropriate list will be put into this column. To edit a client name (job row) or a sub-contractor
name (task row), first move to the name by using the keyboard (arrow keys, tab, enter) or left
mouse clicking. Then hit the enter key. A drop-down name list will appear. Select the correct
name in the drop-down list by 1) using the arrow keys to move to it and then hitting enter or tab
or 2) by left mouse clicking. The drop-down list will disappear and the name you selected will
replace the old name. If you used method 1 to select the name, you’ll be positioned to the name
following the one you just edited. To get out of an edit without updating the old name and
maintain your current position, hit the Esc key. You can also go into the edit mode without
having to hit the enter key by right mouse clicking the name.

Date Columns
The section “Frozen rows 1-3” has a brief discussion of the date columns. These are the columns
representing the days that a sub-contractor would be working on a task. For working days, the cell
would contain either the sub-contractor code or possibly (in the case of the main contractor) the number
of men working on that task that day. The cells will be blank for non-working days. The cells are toggle
switches and can be set, unset or moved. To set an individual cell, right mouse click the cell. If it is
blank and the sub-contractor associated with the task is not the main contractor, the cell will be set to the
sub-contractor’s code. If the sub-contractor is the main contractor and hasn’t elected the option of
putting in man numbers, the cell setting will also be set to the code. When the main contractor is using
man numbers, a drop-down list of numbers will appear allowing you to select the number of men
working that day. A non-blank cell will be set to blank in all cases. To set or move a group of cells, first
highlight the group by moving the mouse over the first (leftmost) cell, pushing the left mouse button
down, moving the mouse to the last cell in the group and letting up the left mouse button. To set a row,
right mouse click the row in the selection. MPTool will examine the first cell in that row. If it is blank,
all the selected cells in that row will be set as working days. If it is non-blank, all the selected cells in
that row will be blanked. To move the selected group, right mouse click a day of any month in row 2.
The entire selected group will be moved to that date.
Creating Job and Task Rows
The previous sections discussed how to change the Manpower date columns, set a range for building
schedules, do overbook and late/unscheduled checks, edit the job and task descriptions, assign client and
sub-contractor names to jobs and tasks and designate task working days. But how do the job and task
rows get in and out of the Manpower window? Notice how the rows in the example have numbered row
headers. Right mouse clicking any of the row headers associated with jobs, tasks or the last empty row
(in the example this would be rows 4 through 20) brings up menus with different options that let you
create, delete, move, save job and task rows and assign employees to tasks.

Job Row Menu Options
·

Add Job And - Add a new job row and 1 to 10 new task rows. The rows will be added directly
above the job row you right mouse clicked on.

·

Add to Job - Add 1 to 10 new task rows to the job you right mouse clicked on. The rows will be
added directly below the job row you right mouse clicked on.

·

Add Job From Template - Add a new job and task rows that have descriptions and client/subcontractor settings from a previously saved template. The new job and task rows are added above
the job row you right mouse clicked on.

·

Replace Job in Template - Save the job and associated task rows’ description and client/subcontractor settings into a template. You can have up to 10 templates.

·

Move Selected Job Above Here - Move a selected job above the job row you right mouse
clicked on. Before using this option, select a job to be moved by left mouse clicking on that job
row.

·

Move Selected Job Below Here - Move a selected job below the job you right mouse clicked
on.

·

Move Selected Task Below Here - Move a selected task directly below the job row you right
mouse clicked on. The selected task must belong to the job.

·

Delete Job - Delete the job you right mouse clicked on and all its tasks

·

Delete Completed Tasks - Delete all tasks associated with this job that are checked as
completed.

·

Assign Employees – Selecting this option brings up a small window showing the names of all
the employees you’ve put into the employee list. The window title will contain the row number
and the first 30 characters of the job description. Highlight the employees and then left mouse
click the add or delete button. These employees will be assigned or de-assigned from all the
tasks defined for this job. Employee assignments will appear in the generated Day schedules.
You can select multiple names by holding down the control key as you left mouse click.

Task Row Menu Options
·

Add to Job - Add 1 to 10 new task rows to the job associated with the task row you right mouse
clicked on. The rows will be added directed below the task row you right mouse clicked on.

·

Move Selected Task Below Here - Moves a selected task directly below the task row you right
mouse clicked on. The selected task must belong to the same job as the task it will be moved
under.

·

Delete Task - Delete the task row you right mouse clicked on.

·

Assign Employees – This option is similar to the job row option of the same name except
assignments and de-assignments are made to a single task. The names of the assigned employees
will be highlighted when the assignment window appears.

Last Row Menu Options
·

Add Job And - Add a new job row and 1 to 10 new task rows. The rows will be added directly
above the last row.

·

Add Job From Template - Add a new job and task rows that have descriptions and client/subcontractor settings from a previously saved template. The new job and task rows are added above
the last row.

·

Move Selected Job Above Here - Move a selected job above the last row.

Building Schedules

Once you’ve input a job into Manpower, it’s time to build your schedules. The first step for building
schedules is setting the range. See ‘Range Settings’ in the ‘Frozen Rows 1-3’ section for details. The
range determines how much of the Manpower data will be used when schedules are created. For

instance, let’s say you set your range to include just one row of a task. Then, only one Job schedule or
one Sub-Contractor schedule would be built which contained information for that one task. If you set the
range to include all the Manpower data, a Job schedule for every job and a Sub-Contractor schedule for
every Sub-Contractor would be built. Once you’ve set the range, use the Build menu to build Job
Schedules, Sub Schedules and Day Schedules. A message is sent to the message area as each schedule is
built followed by a final message indicating schedule building is done. You can then left mouse click the
‘Schedules’ menu item under the View menu to go to the Schedules window to view, edit, print and email the generated schedules.
Option Settings
Left mouse clicking the Options menu item displays a group of tabbed pages that allow you to edit the
MPTool options. Each page contains the options associated with the category name on the tab. The
pages are stacked so only the top page is visible. Left mouse clicking on any tab will move that page to
the top of the stack. In addition to the category options, each page has a Save button and a message area.
Left mouse click the Save button to save the current settings for the category. The message area will
display a message saying whether or not the option settings were successfully updated.

If your computer has a MODEM, MPTool can be set up to automatically dial your clients and subcontractors when you right mouse click one of their numbers in the Clients or Subs windows. Your
MODEM has ports for two phone cords called line and phone. Run one phone cord from the wall to the
line port. Run the other from your phone to the phone port. Check to make sure your phone still operates
normally whether or not your computer is running. Next set the options as explained below.
·

MODEM Port - left mouse click the pull down list and select the number of the COM port the
MODEM is using. (You can find this information in Control Panel under Phones and MODEM
options) Selecting 0 disables this feature.

·

Local Area Code - Type in your 3 digit area code.

·

Outside Line - Some phones require an additional prefix to get an outside line. Left mouse click
the pull down list and select the prefix if needed. Selecting 0 means no prefix.

·

Delay Time – This number is in tenths of a second. The delay time is the time needed for
MPTool to dial the number and let the phone start ringing. The default time is eight tenths of a
second. Left mouse click the pull down list and a pick a number to adjust the delay.

When using a speaker phone, turn the speaker on before right mouse clicking the number to dial.
E-Mail Options

(AT&T and Time Warner Sample Settings)
Schedules generated by MPTool can be sent to your clients and sub-contractors in three ways. They can
be printed out so you can FAX them. They can also be e-mailed directly from MPTool or from your
POP 3 e-mail program. (e.g. Outlook) See the section on the Schedules window for how to print and email schedules. The e-mail created contains a single line of text thanking the receiver for using your
services. The schedule, which has been converted to a PDF file, is attached to the e-mail. The PDF
format was chosen since most internet users have downloaded the free viewer (Acrobat reader) from the
Adobe web site. This lets your e-mail receivers see and print your schedules without requiring them to
purchase any software.
·

Blind Copy – If you want to have a copy sent to the main contractor’s e-mail address
whenever you e-mail schedules to the clients or sub-contractors, check this box. The ‘Blind’
means the mail received by your clients and sub-contractors will not indicate you’ve been
copied. This allows you to keep a record of all schedules you’ve e-mailed.

·

Zip Attached PDF – If you want the attached PDF to be sent as a zip file, check this box.

The options below must be set to e-mail schedules directly from MPTool. They let MPTool
know what mail server (SMTP) will be used to forward your out-going mail and what it requires.
You can contact your ISP who owns the server to get these settings or you get them from your
account settings if you have set up a POP 3 program (e g Outlook) on your machine. It is not
necessary to set these options if you’re using your POP 3 program to send schedules.
·

SMTP Server - Type in the name the of the mail server.

·

Authorization - Check this box if the SMTP server requires a user name and password.

·

User Name - Type in the user name needed by the server for authorization.

·

Password - Type in the password needed by the server for authorization

·

Secure Send - Left mouse click the pull down box and select the type of encryption. The
choices are None, SSL, TLS.

·

Port - Type in the number of the port that is used to send e-mail.

General Options

The general settings allow you to change the Font Size on the Manpower, Clients, and Subs window and
change the default column widths of columns 2 and 3 on the Manpower window. Note that the Font Size
setting requires you to shutdown and restart MPTool to see the effect.
·

Font Size - Left mouse click the pull down list and select the Font size.

·

Jobs/Tasks Column Width - Left mouse click the pull down list and select the width. The
numbers represent the approximate number of characters that can be seen.

·

Clients/Subs Column Width - Same as Jobs/Tasks option.

MPTool Working Data
The first time you run MPTool, you’re asked to choose a disk location for the ‘mpdata’ directory. That
directory will contain a file called workingdata.mdb which is used to store your input data along with
your latest schedules. Each time you start MPTool, the information from the workingdata.mdb file is
brought into tables in your computer memory. As you make changes, the changes are recorded in these
memory tables. The changes are not permanent until they’re written back to the workingdata.mdb file.
You can make your temporary changes permanent at any time (cause them to written back to the

workingdata.mdb file) by left mouse clicking the ‘Save’ menu item. When you close MPTool, a check
will be done to see if there have been any changes that have not been saved. If there are, you will be
given the option to save or discard them.
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Backing Up Working Data
The backup process makes a copy (a backup file) of the working data. You can recover the data in a
backup file by using the ‘Restore’ menu item (See ‘Restoring Working Data From a Backup File’
below). Backup files can be used to prevent data loss, move MPTool data from one computer to another
or even split your MPTool data into multiple files. To start a backup, left mouse click the ‘Backup’
menu item. MPTool will first check to see if you have any working data changes not yet saved. If there
are outstanding changes, they will automatically be saved to the workingdata.mdb file. Next, a window
will appear letting you choose the folder and filename for the backup. You may also choose a writeable
CD. To keep the backup files small, MPTool deliberately does not save any of the Job or SubContractor schedules you’ve built. This tradeoff is that the backup and restore processes are fast, but the
schedules must be rebuilt after restoring from a backup file.
Restoring Working Data
The ’Restore’ menu item lets you replace the working data in the workingdata.mdb file and memory
tables with the data from one of your backup files. Left mouse click the ‘Restore’ menu item to start.
Since your working data will be over written, MPTool will first ask if you want to back up the current
working data. After your current data has been backed up, a window will appear letting you browse to a
backup file to restore from. Highlight the file by left clicking on it and then left click the ‘Open’ button.
MPTool will start restoring your data and give you a message when the restore has finished. When the
restore is done, the Manpower, Clients, Subs and Employees windows will contain the same information
they did at the time the backup was made. The Schedules window will not have any Schedules.
Resetting Working Data
The ‘New’ menu item deletes all job information, sets the starting date to today and the number of date
columns to 180. The manpower window appears as it does the first time you started MPTool. When the
reset is done, the Clients, Subs and Employees windows will contain the same information they did the
time the reset was started. This allows you to start a new ManPower window without re-entering your

list information. The Schedules window will not have any Schedules. Since your working data will be
over written, MPTool will first ask if you want to back up the current working data before doing the
reset.
Help - About

The About menu item will display three sections of information about MPTool. The first section
describes the tool, the version being used and your license information. The second shows you where
the MPTool data and program are installed. The third contains contact information for pre-sales
questions. Please use e-mail or the forum at www.systemguys.com for any technical issues.
Help – License Options

Use the License Options sub-menu (under Help) to bring up the License install window.

Help – New Version Check
The New Version Check sub-menu (under Help) will try to access the on-line download site to see if a
new version of MPTool is available for download. If the download site cannot be reached, a message to
try again later will be displayed. If the download site’s version is the same as you’re currently using, a
message will tell you so. If the download site’s version is different, the message will show the version
number on the site and give you the option of doing an update. If you choose to update, MPTool will be
closed and the download page will appear in your web browser to allow you to install the new version.
Employee and Client List Windows

Sub Contractor List Window

The Client list, Sub list and Employee list windows contain the names, phone numbers, addresses and email addresses of your clients, sub-contractors and employees. This section will describe all these
windows since you create, delete and edit these lists in the same way. The only difference between a
sub-contractor record and a client record is that the sub-contractor record has two additional input fields
called Code and Contact. The Code is a two digit code used for indicating working days in the
Manpower display (see the Manpower window section for a full explanation). The Contact field is used
for the sub-contractor’s contact name. This extra field is needed since the name field of the subcontractor record is used for the sub-contractor’s business name.
Editing List Records

The top row (between the column headers and the start of the list) is used to edit all client and subcontractor information. Moving into the top row puts you into an edit mode. Moving out of the row ends
the edit mode. Changes are made to the rows below when you right mouse the number 1 on the top row
and then left mouse click the Add or Replace menu items. You can begin an edit with all the edit fields
blank by using the arrow keys to move into the top row or left mouse clicking any cell in the top row.
Only the Add menu item is enabled if you start the edit mode this way. Right mouse click on any other
row’s number and select Edit Row to start the edit with a copy of that row’s information. If you start an
edit this way, both the Add and Replace menu items are enabled letting you add your changes to a new
row or replace the information in the row you copied from. When editing in the top row, use the Tab key
to move left to right across the fields. Hitting Tab in the last field will wrap to the first field of the top
row. Holding down the Shift key when you hit Tab will move you right to left. If you do this in the first
field, you will wrap to the last field in the top row. If you’re in the middle of a field edit and decide you
want to restore the field’s original information, hit the Esc key. Then hit either Enter (to begin the edit
again in the same field) or Tab.
Deleting Records
Right mouse click the row number you want to delete and then left mouse click the Delete menu item.
Setting a Sub-Contractor to be the Main (only on the Subs window)
Right mouse click the row number containing the sub-contractor you want to make the main contractor.
(Usually, that’s your company) Then left mouse click the Set Sub Main menu item. A small window
will appear asking if you want to use man numbers for this sub-contractor when indicating working days
in the Manpower window. If you choose not to take this option, the sub-contractor’s two character code
will be used (see the Manpower window section for a full explanation). Once you’ve made your choice,

the small window goes away and the Name field in the sub-contractor row changes color indicating this
sub-contractor is now set to be the main contractor. From this point on, schedules generated by MPTool
will have this sub-contractor’s information in the title fields.
Dialing a Client or Sub-Contractor
If you set up the dialing option (see Dial Settings in the Options Settings section), right mouse clicking
on a field containing a phone number will automatically dial that number.
Printing the List

Left mouse clicking the Print menu item will send a formatted list of your clients or sub-contractors to
your default printer. If you hold down the CTRL key when you click on Print, a print dialogue will
display allowing you to choose a different printer. If you hold down the Shift key when you click on
Print, the print will be sent to a preview window.

The Schedules window allows you to view, edit, print and e-mail your Job, Sub-Contractor and
Employee schedules. Notice the lists on the left hand side of the window. The Job schedules are listed
by the job descriptions that were input into the Manpower window. The Sub Schedules are listed by the
sub-contractor names that were input into the Subs window. The Day schedules are listed by the date
and day of the week. Only the last schedule you generated for a schedule is available.
View-Edit Area
The area on the right side of the schedules window lets you view a schedule and edit the comments row.
Left mouse clicking a schedule in any of the schedule lists will display the schedule in the view-edit
area. To edit the comments, first move to the comments by using the keyboard (arrow keys, tab, enter)
or left mouse clicking. Then hit the Enter key. An editable text box with the comments will appear. Edit
the text and hit either the tab key or the enter key. The text box will disappear and the modified text will
replace the old comments. You’ll be positioned to the location following the comments you just edited.
To get out of an edit without updating your changes and maintain your current position, hit the Esc key.
You can also go into the edit mode without having to hit the enter key by right mouse clicking the
comments.

Selecting Schedules
The Print, E-mail, Delete, Edit E-mail and Save To PDF menu items apply to the selected schedules
(high-lighted) in a list. A single schedule can be selected by left mouse clicking on it. To select a
contiguous range of schedules, left mouse click the first schedule in the range. Then hold down the shift
key and left mouse click the last schedule in the range. To add a non-contiguous schedule to those
already selected, hold down the Ctrl key and left mouse click the schedule.
Printing Schedules
Select the schedules to be printed and left mouse click the Selected Schedules menu Choose the type of
selected schedules you want to print and then select the print menu item. The selected schedules will be
printed to the default printer. If you hold down the Ctrl key when you left mouse click the Print button, a
print dialogue will appear letting you pick an alternate printer. If you hold down the Shift key when you
left mouse click the Print button, the print will be displayed in a preview window.
Deleting Schedules
Select the schedules to be deleted and left mouse click the Selected Schedules menu. Choose the type of
selected schedules you want to delete and then select the delete menu item.

E-Mailing Schedules With or Without Editing
The E-mail menu item will only be enabled if you’ve set up the SMTP options. (See E-mail Settings in
the Options section) Select the schedules and left mouse click the Selected Schedules menu. Choose the
type of selected schedules you want to e-mail and then select either the E-mail menu item or the Edit
Email menu item. The E-mail menu item will immediately send the schedules with the default message.
The Edit Email menu item will bring up your default Email program (e.g. Outlook) allowing you to
change the default message or add additional attachments. The edited mail will be sent to your Email
program’s outbox. Your Email program will then send the edited mail to your client. Job schedules will
be sent to the associated client’s e-mail address. Sub-Contractor schedules will be sent to the subcontractor’s e-mail address. The sender’s e-mail address will be the e-mail address of the main
contractor

Saving Schedules as PDF’s
By default, MPTool only retains the latest schedules you build. You can save a copy of any schedule as
a PDF document. Select the schedules and left mouse click the Selected Schedules menu. Choose the
type of selected schedules you want to delete and then select the Save To PDF menu item. Choose the
folder you want to save the PDF’s to. (the default folder is your MPTdata folder). The schedules will be
saved as xxxx.pdf files where xxxx is the name of the schedule you selected.
.

Getting Started
Here are some initial steps to help get you started after installing the tool. Inside the parenthesis is the
section of the document which explains how the step is done. The steps below only cover the basics.
Once you have the feel of how MPTool works, try some of the other features explained in the sections
above.
·

Input at least one client (Adding and Replacing Records under Clients window)

·

Input at least one sub-contractor (Adding and Replacing Records under Subs window)

·

Set a sub-contractor to be the main contractor (Setting a Sub-Contractor to be the Main under
Subs window)

·

Add jobs and associated task rows (Creating Job and Task Rows under Manpower window)

·

Edit the job and task descriptions (Job and Task descriptions under Frozen Columns 1-3)

·

Assign client and sub-contractor names to the job and task rows (Client and Sub-Contractor
Names under Frozen Columns 1-3)

·

Indicate sub-contractor working days (Date Columns under Manpower Window)

·

Set a range for schedule building (Range Setting under Frozen Rows 1-3)

·

Build the schedules (Building Schedules under Manpower Window)

·

View and edit the generated schedules (View-Edit Area under Schedules Window)

·

Back up your data (Backing Up MPTool Data under Manpower Window)

·

Restore your data from a back up (Restoring MPTool Data under Manpower Window)

